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Introduction 

In 2019, CMS engaged with stakeholders to get an understanding of electronic clinical quality measure 
(eCQM) implementation and reporting burden and asked for recommendations for improvement in the 
use of eCQMs in CMS quality reporting programs. One thing CMS heard was that eCQM development 
was insufficiently transparent. Stakeholders did not have the opportunity to comment on eCQMs early 
in development or to even suggest concepts for measurement. To answer that call, CMS began 
developing the Measure Collaboration (MC) Workspace.  

The MC Workspace, found on the Electronic Clinical Quality Improvement (eCQI) Resource Center, 
has three modules designed to engage stakeholders in the different stages of the Measure Lifecycle. It 
is a place for different stakeholders to come together to suggest eCQM concepts for further 
development (eCQM Concepts) and for measure developers to share opportunities to test an eCQM 
while it is in development (eCQM Testing Opportunities). The measure developer may ask stakeholders 
to test different aspects of the eCQM such as the feasibility of the eCQM. The eCQM Data Element 
Repository (DERep) provides detailed information about data elements used in eCQMs in CMS 
programs. 

CMS encourages a variety of stakeholders to participate in the Measure Lifecycle, to include persons, 
families, and measured entities. There are several different ways stakeholders can participate in the 
Measure Lifecycle. For example, the MC Workspace is an informal way to get involved, whereas 
participating in a Technical Expert Panel is a more formal way of involvement. CMS is very interested in 
persons’ and families’ thoughts on what issues measured entities should measure and how. CMS also 
wants to decrease the implementation and reporting burden of quality measures on measured entities. 

This User Guide explains how to obtain the different roles and the allowed activities of each role. 

MC Workspace Terminology 

• Suggested eCQM Concept – an idea for quality measurement 

• eCQM Testing Opportunity – measure developers looking for volunteers to test eCQMs 

MC Workspace Roles 

There are two roles available for MC Workspace users.  

• Anonymous User 

• Authenticated User 

Behind the scenes are the Site Moderators and the Site Administrators. The Site Moderators review all 
submissions to the eCQM Concepts and eCQM Testing Opportunities modules. 

Anonymous User 

An Anonymous User is any visitor to the MC Workspace without login credentials. The Anonymous 
User can view and search public content, download public documents, but cannot comment. The 
Anonymous User does not need to perform any action to view the eCQI Resource Center and MC 
Workspace. 

Authenticated User 

An Authenticated User is someone who registered for and received a username and password for the 
eCQI Resource Center. Among other things, an Authenticated User may suggest eCQM concepts and 
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comment on other’s suggested eCQM concepts. The Site Moderator reviews all submissions and may 
request additional information or approve as is for public viewing. 

Activities an Authenticated User May Perform 

An Authenticated User can do everything (view, search, and download public content) an Anonymous 
User can. An Authenticated User also has the ability to sign up to receive topic updates by selecting 
“Receive updates on this topic” at the top of most eCQI Resource Center pages. If not already logged 
in, the Log in page will appear. If you do not have an eCQI Resource Center username and password, 
please request an account. 

An Authenticated User has the ability to enter comments in the MC Workspace in the eCQM Concepts 
module and enter a suggested eCQM concept on the eCQM Concepts page. You can request an eCQI 
Resource Center account from any eCQI Resource Center page. 

Requesting an eCQI Resource Center Account 

An Anonymous User must request an eCQI Resource Center account and receive a password to be an 
Authenticated User.  

1. From any page on the eCQI Resource Center, select “Manage Your Account” in the upper banner, 
then select “Create new account.” See Figure 1. Alternatively, if you are on the eCQM Concepts 
page, select “Create a new account.” See Figure 2. 

Figure 1 Request an eCQI Resource Center Account 

 

Figure 2 Create New Account From eCQM Concepts Page 
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2. Scroll down and fill in the fields. The required fields are those marked with a red asterisk *. See 
Figure 3. 

Figure 3 Creating an eCQI Resource Center Account 

 

3. Check or uncheck the boxes under email preferences based on your preferences and select 
“Create new account.” See Figure 4. 

Figure 4 Email Preferences 

 

4. A green confirmation banner appears just under the upper banner. See Figure 5.  

Figure 5 Confirmation Banner 
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5. You will receive a “Welcome” email with one-time login link directing you to set your password.  

a. Follow the instructions in the email. 

b. If you do not get an email, please check your spam folder. If not in your spam folder, please 
contact the eCQI Resource Center at ecqi-resource-center@hhs.gov. 

c. While the process of setting up a new account is automated, eCQI Resource Center personnel 
monitor all new account requests and review for suspicious emails. You may get an email from 
eCQI Resource Center personnel requesting additional information. 

  

file:///C:/Users/lesh/AppData/Local/Box/Box%20Edit/Documents/LkwGfY+Io0ON5b7x5ms4mA==/ecqi-resource-center@hhs.gov
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Suggesting an eCQM Concept 

An Authenticated User may suggest an idea for a new eCQM. We encourage ideas from all 
stakeholders including, but not limited to persons and families, patient advocates, and point of care 
clinicians. Prior to suggesting an eCQM concept, we recommend you check the CMS Measures 
Inventory Tool (CMIT) and the National Quality Forum Quality Positioning System (QPS) to see if a 
measure developer is already addressing your idea, and any suggested eCQM concepts listed under 
Suggested eCQM Concepts on the eCQM Concepts page to see if someone else has suggested the 
same idea. See Figure 6. 

Figure 6 Suggested eCQM Concepts 

 

There is a note if there currently are no suggested concepts. See Figure 7. 

Figure 7 No Suggested eCQM Concepts 

 

1. After logging in, your screen changes and you get instructions and a button to suggest an eCQM 
Concept. See Figure 8.  

Figure 8 Suggest an eCQM Concept 

 

https://cmit.cms.gov/CMIT_public/ListMeasures
https://cmit.cms.gov/CMIT_public/ListMeasures
https://www.qualityforum.org/QPS/
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2. Select “Suggest an eCQM Concept.” The Create eCQM Concept page opens. See Figure 9. There 
are four required fields each marked with a red asterisk– Title, Description, Place of Care, and 
Rationale. Provide a descriptive title, then provide a description of the concept.  

Figure 9 Suggest an eCQM Concept Title and Description 

 

3. In the Place of Care section, there is an alphabetized dropdown with several options, including 
other. See Figure 10. Select the best option for your eCQM concept.  

Figure 10 Place of Care Dropdown 
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4. In the Rationale section, provide a description as to why you think it is important to measure this 
concept. See Figure 11. Concept population is optional. Files provides the opportunity to attach any 
additional documentation to explain or justify your suggested eCQM concept. 

Figure 11 Suggested eCQM Concept Rationale 

 

5. After entering content in the four required fields, you may start the submission and save to continue 
working on the suggested eCQM concept later by selecting “Continue Later” at the bottom of the 
page or, if satisfied with your suggested eCQM Concept, select “Request Public Viewing.” See 
Figure 12. 

Figure 12 Initiate Submission of Suggested eCQM Concept 

 

6. Regardless of whether you selected “Continue Later” or “Request Public Viewing,” a new page with 
a green banner appears at the top of the page confirming creation of your concept. See Figure 13. 

Figure 13 Confirmation of Creation of eCQM Concept 

 

7. If you selected “Continue Later,” you can continue to edit your suggested concept by selecting the 
“Edit” tab. If you selected “Request Public Viewing,” you cannot edit the concept until the Site 
Moderator acts on your suggested eCQM concept. 
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8. To complete submission of your suggested eCQM concept, log in and your dashboard appears. 
Select “My eCQM Concepts.” Select the “Edit” operation on the row of the suggested eCQM 
concept you want to complete. See Figure 14. 

Figure 14 Edit Your Suggested eCQM Concept 

 

9. The edit screen is essentially the same as the initial create screen. When you are ready to submit 
your suggested eCQM concept, select “Request Public Viewing.” See Figure 13.  

10. As noted earlier, once the suggested eCQM concept is In Review status, you cannot edit the 
content. You can, however, delete the suggested eCQM. When you select “Request Public 
Viewing” on a suggested eCQM concept after previously selecting “Continue Later,” you will see a 
green banner noting updates to the concept. See Figure 15. 

Figure 15 Green Banner Noting Update to Suggested eCQM Concept 

 

If you are unsure of the status of your suggested eCQM concept, go to “My Account” in the upper right 
of your screen, and the “View” tab. Look for the suggested eCQM concept. Under the title are two lines. 
The item at the end of the second line indicates the status of your suggested eCQM concept. There are 
three possible statuses – “Draft,” “Needs Review,” and “Published.” See Figure 16. 

• “Draft” means you have not yet submitted the suggested eCQM concept for public viewing or the 
Site Moderator sent the suggested eCQM concept back for edits.  

• “Needs Review” means you have submitted the suggested eCQM concept for public viewing.  

• “Published” means you have submitted the suggested eCQM concept for public viewing and the 
Site Moderator approved the suggested eCQM concept for public viewing.  
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Figure 16 Checking the Status of Your Suggested eCQM Concept 
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Email Notifications When Creating a Suggested eCQM Concept 

Both you and the Site Moderator receive an email notification when you select “Continue Later” (See 
Figure 17) and “Request Public Viewing” (see Figure 18).  

Figure 17 Example Email When Select “Continue Later” 

 

Figure 18 Example Email When Select “Request Public Viewing” 

  

The Site Moderator reviews all submissions. When you select “Continue Later,” the Site Moderator 
reviews the suggested eCQM concept for things such as appropriateness, vulgarity, spam and may 
either delete the suggested eCQM concept or add comments to the Description and/or Rationale. You 
will not receive an email notification if the Site Moderator deletes or adds comments. You will see any 
comments when you return to the suggested eCQM concept to continue editing. Only the suggested 
eCQM concept author and Site Moderator can edit the suggested eCQM concept. 

When you select “Request Public Viewing,” the Site Moderator reviews and either approves for public 
viewing or returns the suggested eCQM concept back to draft with comments. Both you and the Site 
Moderator receive an email notification of the change to draft status. See Figure 19. 
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Figure 19 Example Email When Site Moderator Returns the Suggested eCQM Concept to Draft 

 

The Site Moderator may correct grammar and spelling prior to approval without asking you to edit, but 
will not change the intent of the suggested eCQM concept. 

After the Site Moderator approves your suggested eCQM concept, you can create a new draft by 
returning to the “Edit” tab and selecting “Create New Draft.” Your original suggested eCQM concept 
remains in “Published” status. A green banner notes you updated the concept and you are now in the 
“Latest Version” tab. See Figure 20. 

Figure 20 Editing a Published Suggested eCQM Concept 

 

Both you and the Site Moderator receive an email notification. The email has the same subject and 
content as when the Site Moderator moves a suggested eCQM concept back to draft. 

The “View” tab displays the published version. The “Edit” tab displays the new draft version. 
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Submitting a Suggested eCQM Concept to CMS for Review 

You may request CMS review your suggested eCQM concept. Open the suggested eCQM concept you 
want CMS to review. Go to the edit tab and select “Request CMS Review.” In addition to the four 
required fields, you must also complete the “Concept Population” field. See Figure 21. 

Figure 21 Requesting CMS Review of Suggested eCQM Concept 

 

Both you and the Site Moderator receive an email notification of an update to your suggested eCQM 
concept. 

The Site Moderator will review your suggested eCQM concept for completeness and forward according 
to an established workflow. If the Site Moderator believes the suggested eCQM concept needs 
additional information, e.g., concept population, they will send the suggested eCQM concept author an 
email describing the requested additional content.  
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Deleting Your Suggested eCQM Concept 

1. At any time, you may delete your suggested eCQM concept. After logging in, go to the “My eCQM 
Concepts” tab of your dashboard. From the Operations column, select the drop down for the 
suggested eCQM concept you want to delete and select “Delete.” See Figure 22. 

Figure 22 Deleting Your Suggested eCQM Concept 

 

a. If your suggested eCQM concept is in “Published” or “Submitted to CMS” status, you will only 
see the option to delete. Alternatively, you can delete your suggested eCQM concept by 
selecting the name of the suggested eCQM concept you want to delete. A screen returns with 
the suggested eCQM concept’s information. Select the “Delete” tab. See Figure 23. 

Figure 23 Deleting Your Suggested eCQM Concept from the Delete Tab 

 

2. Using either method, a screen returns asking you to verify you want to delete. You cannot undo this 
action. If you are sure you want to delete, select “Delete”, otherwise select “Cancel.” See Figure 24. 

Figure 24 Deleting Your Suggested eCQM Concept 

 

3. Once you select “Delete,” you return to the eCQI Resource Center home page. 
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Commenting on Your or Other’s Suggested eCQM Concepts 

If there are other suggested eCQM concepts in the library, an Authenticated User may comment on the 
suggested eCQM concept. 

1. The Authenticated User selects the name of the eCQM for which they want to comment. See Figure 
25. 

Figure 25 Select Suggested eCQM Concept for Comment 

 

2. If not logged in, you will get a prompt to log in or register for an account. See Figure 26. 

Figure 26 Log in to Comment on a Suggested eCQM Concept 
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3. Once logged in, the screen will show the suggested eCQM concept entry and an “Add new 
comment” field. See Figure 27. 

Figure 27 Adding a Comment to a Suggested eCQM Concept 

 

4. Add your comment and select “Preview” to review your comment or “Save” to complete your 
comment. When you select “Save,” you will get a green banner noting submission of your comment. 
See Figure 28. 

Figure 28 Green Banner Indicating Comment Sent 

 

5. The Site Moderator receives an email notification and reviews your comment for appropriateness. If 
the Site Moderator deems your comment appropriate, they will approve your comment for public 
viewing. If not, the Site Moderator will email you with questions and/or ask you to edit. 

6. If someone comments on your suggested eCQM concept and the Moderator approves the 
comment, you receive an email notification of the approved comment. See Figure 29. 

Figure 29 Email Notification to Suggested eCQM Concept Author of Comment Publication 
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7. The main suggested eCQM Concepts page notes how many approved comments a suggested 
eCQM concept has, which anyone can see. However, the Last Updated date does not change. The 
Last Updated date only changes when there are updates to the suggested eCQM concept. See 
Figure 30.  

Figure 30 Public Notification of Number of Approved Comments 

 

8. When opening the suggested eCQM concept, anyone can see the approved comment. See Figure 
31. 

Figure 31 Public Viewing of Approved Comment 
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eCQM Testing Opportunities Module 

Measure developers may request the posting of an announcement of an eCQM testing opportunity. 
There are numerous reasons e.g., feasibility, reliability, validity, and times a measure developer tests 
an eCQM. The eCQM Testing Opportunities module lists a few reasons. If you are a CMS-contracted 
measure developer, please use your CMS cleared announcement using the eCQI template and attach 
to an email to the eCQI Resource Center. If not a CMS-contracted measure developer, please send an 
email to the eCQI Resource Center with the completed template, which includes 

• the name of the organization sponsoring the eCQM 

• dates the organization is accepting testing volunteers 

• type of feedback the organization wants – and it may be multiple topics, e.g., feasibility of data 
elements, thoughts from persons and families, reliability, and validity testing 

• the draft eCQM specifications 

• organization contact information 

If the Site Moderator approves, the eCQI Resource Center team will post the announcement of the 
eCQM Testing Opportunities page. The eCQI Resource Center team will remove the announcement at 
the end of the period the organization is accepting volunteers. Should you want to extend the period, 
please send an email to the eCQI Resource Center. 

If you are a stakeholder interested in testing eCQMs, review the opportunities in the table at the bottom 
of the eCQM Testing Opportunities page. The hyperlink in the “Details” cell provides the specific 
information about the testing opportunity. See Figure 32.  

Figure 32 Learn More About eCQM Testing Opportunities 

 
  

https://ecqi.healthit.gov/sites/default/files/Call%20for%20eCQM%20Testing%20Volunteers%20Template.docx
mailto:ecqi-resource-center@hhs.gov
mailto:ecqi-resource-center@hhs.gov
mailto:ecqi-resource-center@hhs.gov
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eCQM Data Element Repository (DERep) 

DERep Overview 

The eCQM DERep provides additional clarification for all the data elements associated with published 
and tested eCQMs used in CMS quality reporting and incentive programs and the definitions and 
clinical focus for each data element. There are no access restrictions in the DERep. An Anonymous 
User can filter information by data element, eCQM by measured entity, Quality Data Model (QDM) 
attribute, QDM category, QDM datatype, or QDM entity. The QDM information displayed for an eCQM 
reflects the version used in the development of the eCQM for a specific performance/reporting period.  

The eCQM DERep centralizes information from the measure specification, Value Set Authority Center 
(VSAC), and the QDM to aid in better understanding of the clinical intent and to help with data mapping 
activities. The intent of the eCQM DERep is not to replace those other resources. Please refer to those 
sources for more detailed specifications. 

The DERep updates are part of the eCQM Annual Update process. With the addition of a new year, the 
oldest year drops off so there are always three years for viewing. The DERep contains information for 
the immediate past, current, and immediate future performance/reporting periods and reflects the QDM 
and value set versions for their respective performance/reporting periods. 

How to Apply Filters 

The eCQM DERep has multiple filters to help users easily view information of interest. 

1. From the MC Workspace home page, select the “eCQM Data Element Repository” tab. Select the 
dropdown list of the “Year” filter to view available options. See Figure 33. 

Figure 33 Select Reporting/Performance Period 

 

https://vsac.nlm.nih.gov/
https://vsac.nlm.nih.gov/
https://ecqi.healthit.gov/qdm
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2. Then select the filter option from the drop down menu. Find a description of the information in each 
option below the filter boxes. See Figure 34. 

Figure 34 Select a Filter Option 

 

3. If you know the topic, e.g., part of the title or the CMS ID, you can search that way by entering the 
information in “Search”  
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Individual Measure Pages 

The individual measure pages provide the performance/reporting period, CMS Measure ID, version, 
NQF number, eCQM description, and all the data elements and QDM attributes with hyperlinks used by 
the eCQM. Every page has a link back to the DERep Home Page. See Figure 35. 

Figure 35 Individual eCQM Page Example 

 

Select the +Expand All or the individual ^ to see the details of the data elements and attributes. The 
data elements include information from the VSAC, the QDM datatypes and definitions. The page also 
has links to the MC Workspace home page and the DERep Home Page See Figure 36. You can also 
get directly to the data elements by filtering for eCQM Data Elements. 

Figure 36 Data Element Expanded from Individual eCQM Page 
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You may see a data element with the value set object identifier (OID) at the end, e.g., ["Diagnosis": 
"Bipolar Disorder"] (2.16.840.1.113883.3.464.1003.105.12.1157). This is to disambiguate items with the 
same name, but use a different value set. 

If you select the name of the data element rather than +Expand all or the ^, you also get the eCQMs, 
with hyperlinks, using this data element, see Figure 37, and a link to the MC Workspace home page. 

Figure 37 Data Element List of eCQMs Using that Data Element 
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QDM Category Page 

The QDM category pages provide information from the applicable QDM version. See Figure 38. 

Figure 38 Example QDM Category Page 

 

QDM Datatype Page 

QDM datatype pages contain a description of the datatypes, any data elements defined by the QDM 
datatype, and the QDM attribute(s) associated with the QDM datatype. See Figure 39. 

Figure 39 Example QDM Datatype Page 
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QDM Attribute Page 

The QDM attribute pages display the attribute’s definition and which QDM datatypes use the attribute. 
See Figure 40. 

Figure 40 Example QDM Attribute Page 

 

QDM Entities Page 

The QDM entities page provides the definition of the entity. See Figure 41. 

Figure 41 Example QDM Entities Page 
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	An Anonymous User must request an eCQI Resource Center account and receive a password to be an Authenticated User.  
	1. From any page on the eCQI Resource Center, select “Manage Your Account” in the upper banner, then select “Create new account.” See Figure 1. Alternatively, if you are on the eCQM Concepts page, select “Create a new account.” See Figure 2. 
	1. From any page on the eCQI Resource Center, select “Manage Your Account” in the upper banner, then select “Create new account.” See Figure 1. Alternatively, if you are on the eCQM Concepts page, select “Create a new account.” See Figure 2. 
	1. From any page on the eCQI Resource Center, select “Manage Your Account” in the upper banner, then select “Create new account.” See Figure 1. Alternatively, if you are on the eCQM Concepts page, select “Create a new account.” See Figure 2. 


	Figure 1 Request an eCQI Resource Center Account 
	 
	Figure
	Figure 2 Create New Account From eCQM Concepts Page 
	 
	Figure
	2. Scroll down and fill in the fields. The required fields are those marked with a red asterisk *. See Figure 3. 
	2. Scroll down and fill in the fields. The required fields are those marked with a red asterisk *. See Figure 3. 
	2. Scroll down and fill in the fields. The required fields are those marked with a red asterisk *. See Figure 3. 


	Figure 3 Creating an eCQI Resource Center Account 
	 
	Figure
	3. Check or uncheck the boxes under email preferences based on your preferences and select “Create new account.” See Figure 4. 
	3. Check or uncheck the boxes under email preferences based on your preferences and select “Create new account.” See Figure 4. 
	3. Check or uncheck the boxes under email preferences based on your preferences and select “Create new account.” See Figure 4. 


	Figure 4 Email Preferences 
	 
	Figure
	4. A green confirmation banner appears just under the upper banner. See Figure 5.  
	4. A green confirmation banner appears just under the upper banner. See Figure 5.  
	4. A green confirmation banner appears just under the upper banner. See Figure 5.  


	Figure 5 Confirmation Banner 
	 
	Figure
	5. You will receive a “Welcome” email with one-time login link directing you to set your password.  
	5. You will receive a “Welcome” email with one-time login link directing you to set your password.  
	5. You will receive a “Welcome” email with one-time login link directing you to set your password.  
	5. You will receive a “Welcome” email with one-time login link directing you to set your password.  
	a. Follow the instructions in the email. 
	a. Follow the instructions in the email. 
	a. Follow the instructions in the email. 

	b. If you do not get an email, please check your spam folder. If not in your spam folder, please contact the eCQI Resource Center at 
	b. If you do not get an email, please check your spam folder. If not in your spam folder, please contact the eCQI Resource Center at 
	b. If you do not get an email, please check your spam folder. If not in your spam folder, please contact the eCQI Resource Center at 
	ecqi-resource-center@hhs.gov
	ecqi-resource-center@hhs.gov

	. 


	c. While the process of setting up a new account is automated, eCQI Resource Center personnel monitor all new account requests and review for suspicious emails. You may get an email from eCQI Resource Center personnel requesting additional information. 
	c. While the process of setting up a new account is automated, eCQI Resource Center personnel monitor all new account requests and review for suspicious emails. You may get an email from eCQI Resource Center personnel requesting additional information. 





	  
	Suggesting an eCQM Concept 
	An Authenticated User may suggest an idea for a new eCQM. We encourage ideas from all stakeholders including, but not limited to persons and families, patient advocates, and point of care clinicians. Prior to suggesting an eCQM concept, we recommend you check the 
	An Authenticated User may suggest an idea for a new eCQM. We encourage ideas from all stakeholders including, but not limited to persons and families, patient advocates, and point of care clinicians. Prior to suggesting an eCQM concept, we recommend you check the 
	CMS Measures Inventory Tool (CMIT)
	CMS Measures Inventory Tool (CMIT)

	 and the 
	National Quality Forum Quality Positioning System (QPS)
	National Quality Forum Quality Positioning System (QPS)

	 to see if a measure developer is already addressing your idea, and any suggested eCQM concepts listed under Suggested eCQM Concepts on the eCQM Concepts page to see if someone else has suggested the same idea. See 
	Figure 6
	Figure 6

	. 

	Figure 6 Suggested eCQM Concepts 
	 
	Figure
	There is a note if there currently are no suggested concepts. See 
	There is a note if there currently are no suggested concepts. See 
	Figure 7
	Figure 7

	. 

	Figure 7 No Suggested eCQM Concepts 
	 
	Figure
	1. After logging in, your screen changes and you get instructions and a button to suggest an eCQM Concept. See 
	1. After logging in, your screen changes and you get instructions and a button to suggest an eCQM Concept. See 
	1. After logging in, your screen changes and you get instructions and a button to suggest an eCQM Concept. See 
	1. After logging in, your screen changes and you get instructions and a button to suggest an eCQM Concept. See 
	Figure 8
	Figure 8

	.  



	Figure 8 Suggest an eCQM Concept 
	 
	Figure
	2. Select “Suggest an eCQM Concept.” The Create eCQM Concept page opens. See 
	2. Select “Suggest an eCQM Concept.” The Create eCQM Concept page opens. See 
	2. Select “Suggest an eCQM Concept.” The Create eCQM Concept page opens. See 
	2. Select “Suggest an eCQM Concept.” The Create eCQM Concept page opens. See 
	Figure 9
	Figure 9

	. There are four required fields each marked with a red asterisk– Title, Description, Place of Care, and Rationale. Provide a descriptive title, then provide a description of the concept.  



	Figure 9 Suggest an eCQM Concept Title and Description 
	 
	Figure
	3. In the Place of Care section, there is an alphabetized dropdown with several options, including other. See 
	3. In the Place of Care section, there is an alphabetized dropdown with several options, including other. See 
	3. In the Place of Care section, there is an alphabetized dropdown with several options, including other. See 
	3. In the Place of Care section, there is an alphabetized dropdown with several options, including other. See 
	Figure 10
	Figure 10

	. Select the best option for your eCQM concept.  



	Figure 10 Place of Care Dropdown 
	 
	Figure
	4. In the Rationale section, provide a description as to why you think it is important to measure this concept. See 
	4. In the Rationale section, provide a description as to why you think it is important to measure this concept. See 
	4. In the Rationale section, provide a description as to why you think it is important to measure this concept. See 
	4. In the Rationale section, provide a description as to why you think it is important to measure this concept. See 
	Figure 11
	Figure 11

	. Concept population is optional. Files provides the opportunity to attach any additional documentation to explain or justify your suggested eCQM concept. 



	Figure 11 Suggested eCQM Concept Rationale 
	 
	Figure
	5. After entering content in the four required fields, you may start the submission and save to continue working on the suggested eCQM concept later by selecting “Continue Later” at the bottom of the page or, if satisfied with your suggested eCQM Concept, select “Request Public Viewing.” See 
	5. After entering content in the four required fields, you may start the submission and save to continue working on the suggested eCQM concept later by selecting “Continue Later” at the bottom of the page or, if satisfied with your suggested eCQM Concept, select “Request Public Viewing.” See 
	5. After entering content in the four required fields, you may start the submission and save to continue working on the suggested eCQM concept later by selecting “Continue Later” at the bottom of the page or, if satisfied with your suggested eCQM Concept, select “Request Public Viewing.” See 
	5. After entering content in the four required fields, you may start the submission and save to continue working on the suggested eCQM concept later by selecting “Continue Later” at the bottom of the page or, if satisfied with your suggested eCQM Concept, select “Request Public Viewing.” See 
	Figure 12
	Figure 12

	. 



	Figure 12 Initiate Submission of Suggested eCQM Concept 
	 
	Figure
	6. Regardless of whether you selected “Continue Later” or “Request Public Viewing,” a new page with a green banner appears at the top of the page confirming creation of your concept. See 
	6. Regardless of whether you selected “Continue Later” or “Request Public Viewing,” a new page with a green banner appears at the top of the page confirming creation of your concept. See 
	6. Regardless of whether you selected “Continue Later” or “Request Public Viewing,” a new page with a green banner appears at the top of the page confirming creation of your concept. See 
	6. Regardless of whether you selected “Continue Later” or “Request Public Viewing,” a new page with a green banner appears at the top of the page confirming creation of your concept. See 
	Figure 13
	Figure 13

	. 



	Figure 13 Confirmation of Creation of eCQM Concept 
	 
	Figure
	7. If you selected “Continue Later,” you can continue to edit your suggested concept by selecting the “Edit” tab. If you selected “Request Public Viewing,” you cannot edit the concept until the Site Moderator acts on your suggested eCQM concept. 
	7. If you selected “Continue Later,” you can continue to edit your suggested concept by selecting the “Edit” tab. If you selected “Request Public Viewing,” you cannot edit the concept until the Site Moderator acts on your suggested eCQM concept. 
	7. If you selected “Continue Later,” you can continue to edit your suggested concept by selecting the “Edit” tab. If you selected “Request Public Viewing,” you cannot edit the concept until the Site Moderator acts on your suggested eCQM concept. 


	8. To complete submission of your suggested eCQM concept, log in and your dashboard appears. Select “My eCQM Concepts.” Select the “Edit” operation on the row of the suggested eCQM concept you want to complete. See 
	8. To complete submission of your suggested eCQM concept, log in and your dashboard appears. Select “My eCQM Concepts.” Select the “Edit” operation on the row of the suggested eCQM concept you want to complete. See 
	8. To complete submission of your suggested eCQM concept, log in and your dashboard appears. Select “My eCQM Concepts.” Select the “Edit” operation on the row of the suggested eCQM concept you want to complete. See 
	8. To complete submission of your suggested eCQM concept, log in and your dashboard appears. Select “My eCQM Concepts.” Select the “Edit” operation on the row of the suggested eCQM concept you want to complete. See 
	Figure 14
	Figure 14

	. 



	Figure 14 Edit Your Suggested eCQM Concept 
	 
	Figure
	9. The edit screen is essentially the same as the initial create screen. When you are ready to submit your suggested eCQM concept, select “Request Public Viewing.” See Figure 13.  
	9. The edit screen is essentially the same as the initial create screen. When you are ready to submit your suggested eCQM concept, select “Request Public Viewing.” See Figure 13.  
	9. The edit screen is essentially the same as the initial create screen. When you are ready to submit your suggested eCQM concept, select “Request Public Viewing.” See Figure 13.  

	10. As noted earlier, once the suggested eCQM concept is In Review status, you cannot edit the content. You can, however, delete the suggested eCQM. When you select “Request Public Viewing” on a suggested eCQM concept after previously selecting “Continue Later,” you will see a green banner noting updates to the concept. See 
	10. As noted earlier, once the suggested eCQM concept is In Review status, you cannot edit the content. You can, however, delete the suggested eCQM. When you select “Request Public Viewing” on a suggested eCQM concept after previously selecting “Continue Later,” you will see a green banner noting updates to the concept. See 
	10. As noted earlier, once the suggested eCQM concept is In Review status, you cannot edit the content. You can, however, delete the suggested eCQM. When you select “Request Public Viewing” on a suggested eCQM concept after previously selecting “Continue Later,” you will see a green banner noting updates to the concept. See 
	Figure 15
	Figure 15

	. 



	Figure 15 Green Banner Noting Update to Suggested eCQM Concept 
	 
	Figure
	If you are unsure of the status of your suggested eCQM concept, go to “My Account” in the upper right of your screen, and the “View” tab. Look for the suggested eCQM concept. Under the title are two lines. The item at the end of the second line indicates the status of your suggested eCQM concept. There are three possible statuses – “Draft,” “Needs Review,” and “Published.” See 
	If you are unsure of the status of your suggested eCQM concept, go to “My Account” in the upper right of your screen, and the “View” tab. Look for the suggested eCQM concept. Under the title are two lines. The item at the end of the second line indicates the status of your suggested eCQM concept. There are three possible statuses – “Draft,” “Needs Review,” and “Published.” See 
	Figure 16
	Figure 16

	. 

	• “Draft” means you have not yet submitted the suggested eCQM concept for public viewing or the Site Moderator sent the suggested eCQM concept back for edits.  
	• “Draft” means you have not yet submitted the suggested eCQM concept for public viewing or the Site Moderator sent the suggested eCQM concept back for edits.  
	• “Draft” means you have not yet submitted the suggested eCQM concept for public viewing or the Site Moderator sent the suggested eCQM concept back for edits.  

	• “Needs Review” means you have submitted the suggested eCQM concept for public viewing.  
	• “Needs Review” means you have submitted the suggested eCQM concept for public viewing.  

	• “Published” means you have submitted the suggested eCQM concept for public viewing and the Site Moderator approved the suggested eCQM concept for public viewing.  
	• “Published” means you have submitted the suggested eCQM concept for public viewing and the Site Moderator approved the suggested eCQM concept for public viewing.  


	Figure 16 Checking the Status of Your Suggested eCQM Concept 
	 
	Figure
	  
	Email Notifications When Creating a Suggested eCQM Concept 
	Both you and the Site Moderator receive an email notification when you select “Continue Later” (See 
	Both you and the Site Moderator receive an email notification when you select “Continue Later” (See 
	Figure 17
	Figure 17

	) and “Request Public Viewing” (see 
	Figure 18
	Figure 18

	).  

	Figure 17 Example Email When Select “Continue Later” 
	 
	Figure
	Figure 18 Example Email When Select “Request Public Viewing” 
	  
	Figure
	The Site Moderator reviews all submissions. When you select “Continue Later,” the Site Moderator reviews the suggested eCQM concept for things such as appropriateness, vulgarity, spam and may either delete the suggested eCQM concept or add comments to the Description and/or Rationale. You will not receive an email notification if the Site Moderator deletes or adds comments. You will see any comments when you return to the suggested eCQM concept to continue editing. Only the suggested eCQM concept author and
	When you select “Request Public Viewing,” the Site Moderator reviews and either approves for public viewing or returns the suggested eCQM concept back to draft with comments. Both you and the Site Moderator receive an email notification of the change to draft status. See 
	When you select “Request Public Viewing,” the Site Moderator reviews and either approves for public viewing or returns the suggested eCQM concept back to draft with comments. Both you and the Site Moderator receive an email notification of the change to draft status. See 
	Figure 19
	Figure 19

	. 

	Figure 19 Example Email When Site Moderator Returns the Suggested eCQM Concept to Draft 
	 
	Figure
	The Site Moderator may correct grammar and spelling prior to approval without asking you to edit, but will not change the intent of the suggested eCQM concept. 
	After the Site Moderator approves your suggested eCQM concept, you can create a new draft by returning to the “Edit” tab and selecting “Create New Draft.” Your original suggested eCQM concept remains in “Published” status. A green banner notes you updated the concept and you are now in the “Latest Version” tab. See 
	After the Site Moderator approves your suggested eCQM concept, you can create a new draft by returning to the “Edit” tab and selecting “Create New Draft.” Your original suggested eCQM concept remains in “Published” status. A green banner notes you updated the concept and you are now in the “Latest Version” tab. See 
	Figure 20
	Figure 20

	. 

	Figure 20 Editing a Published Suggested eCQM Concept 
	 
	Figure
	Both you and the Site Moderator receive an email notification. The email has the same subject and content as when the Site Moderator moves a suggested eCQM concept back to draft. 
	The “View” tab displays the published version. The “Edit” tab displays the new draft version. 
	  
	Submitting a Suggested eCQM Concept to CMS for Review 
	You may request CMS review your suggested eCQM concept. Open the suggested eCQM concept you want CMS to review. Go to the edit tab and select “Request CMS Review.” In addition to the four required fields, you must also complete the “Concept Population” field. See 
	You may request CMS review your suggested eCQM concept. Open the suggested eCQM concept you want CMS to review. Go to the edit tab and select “Request CMS Review.” In addition to the four required fields, you must also complete the “Concept Population” field. See 
	Figure 21
	Figure 21

	. 

	Figure 21 Requesting CMS Review of Suggested eCQM Concept 
	 
	Figure
	Both you and the Site Moderator receive an email notification of an update to your suggested eCQM concept. 
	The Site Moderator will review your suggested eCQM concept for completeness and forward according to an established workflow. If the Site Moderator believes the suggested eCQM concept needs additional information, e.g., concept population, they will send the suggested eCQM concept author an email describing the requested additional content.  
	  
	Deleting Your Suggested eCQM Concept 
	1. At any time, you may delete your suggested eCQM concept. After logging in, go to the “My eCQM Concepts” tab of your dashboard. From the Operations column, select the drop down for the suggested eCQM concept you want to delete and select “Delete.” See 
	1. At any time, you may delete your suggested eCQM concept. After logging in, go to the “My eCQM Concepts” tab of your dashboard. From the Operations column, select the drop down for the suggested eCQM concept you want to delete and select “Delete.” See 
	1. At any time, you may delete your suggested eCQM concept. After logging in, go to the “My eCQM Concepts” tab of your dashboard. From the Operations column, select the drop down for the suggested eCQM concept you want to delete and select “Delete.” See 
	1. At any time, you may delete your suggested eCQM concept. After logging in, go to the “My eCQM Concepts” tab of your dashboard. From the Operations column, select the drop down for the suggested eCQM concept you want to delete and select “Delete.” See 
	Figure 22
	Figure 22

	. 
	Figure
	a. If your suggested eCQM concept is in “Published” or “Submitted to CMS” status, you will only see the option to delete. Alternatively, you can delete your suggested eCQM concept by selecting the name of the suggested eCQM concept you want to delete. A screen returns with the suggested eCQM concept’s information. Select the “Delete” tab. See 
	a. If your suggested eCQM concept is in “Published” or “Submitted to CMS” status, you will only see the option to delete. Alternatively, you can delete your suggested eCQM concept by selecting the name of the suggested eCQM concept you want to delete. A screen returns with the suggested eCQM concept’s information. Select the “Delete” tab. See 
	a. If your suggested eCQM concept is in “Published” or “Submitted to CMS” status, you will only see the option to delete. Alternatively, you can delete your suggested eCQM concept by selecting the name of the suggested eCQM concept you want to delete. A screen returns with the suggested eCQM concept’s information. Select the “Delete” tab. See 
	a. If your suggested eCQM concept is in “Published” or “Submitted to CMS” status, you will only see the option to delete. Alternatively, you can delete your suggested eCQM concept by selecting the name of the suggested eCQM concept you want to delete. A screen returns with the suggested eCQM concept’s information. Select the “Delete” tab. See 
	Figure 23
	Figure 23

	. 






	Figure 22 Deleting Your Suggested eCQM Concept 
	 
	Figure 23 Deleting Your Suggested eCQM Concept from the Delete Tab 
	 
	Figure
	2. Using either method, a screen returns asking you to verify you want to delete. You cannot undo this action. If you are sure you want to delete, select “Delete”, otherwise select “Cancel.” See 
	2. Using either method, a screen returns asking you to verify you want to delete. You cannot undo this action. If you are sure you want to delete, select “Delete”, otherwise select “Cancel.” See 
	2. Using either method, a screen returns asking you to verify you want to delete. You cannot undo this action. If you are sure you want to delete, select “Delete”, otherwise select “Cancel.” See 
	2. Using either method, a screen returns asking you to verify you want to delete. You cannot undo this action. If you are sure you want to delete, select “Delete”, otherwise select “Cancel.” See 
	Figure 24
	Figure 24

	. 



	Figure 24 Deleting Your Suggested eCQM Concept 
	 
	Figure
	3. Once you select “Delete,” you return to the eCQI Resource Center home page. 
	3. Once you select “Delete,” you return to the eCQI Resource Center home page. 
	3. Once you select “Delete,” you return to the eCQI Resource Center home page. 


	  
	Commenting on Your or Other’s Suggested eCQM Concepts 
	If there are other suggested eCQM concepts in the library, an Authenticated User may comment on the suggested eCQM concept. 
	1. The Authenticated User selects the name of the eCQM for which they want to comment. See 
	1. The Authenticated User selects the name of the eCQM for which they want to comment. See 
	1. The Authenticated User selects the name of the eCQM for which they want to comment. See 
	1. The Authenticated User selects the name of the eCQM for which they want to comment. See 
	Figure 25
	Figure 25

	. 



	Figure 25 Select Suggested eCQM Concept for Comment 
	 
	Figure
	2. If not logged in, you will get a prompt to log in or register for an account. See 
	2. If not logged in, you will get a prompt to log in or register for an account. See 
	2. If not logged in, you will get a prompt to log in or register for an account. See 
	2. If not logged in, you will get a prompt to log in or register for an account. See 
	Figure 26
	Figure 26

	. 



	Figure 26 Log in to Comment on a Suggested eCQM Concept 
	 
	Figure
	3. Once logged in, the screen will show the suggested eCQM concept entry and an “Add new comment” field. See 
	3. Once logged in, the screen will show the suggested eCQM concept entry and an “Add new comment” field. See 
	3. Once logged in, the screen will show the suggested eCQM concept entry and an “Add new comment” field. See 
	3. Once logged in, the screen will show the suggested eCQM concept entry and an “Add new comment” field. See 
	Figure 27
	Figure 27

	. 



	Figure 27 Adding a Comment to a Suggested eCQM Concept 
	 
	Figure
	4. Add your comment and select “Preview” to review your comment or “Save” to complete your comment. When you select “Save,” you will get a green banner noting submission of your comment. See 
	4. Add your comment and select “Preview” to review your comment or “Save” to complete your comment. When you select “Save,” you will get a green banner noting submission of your comment. See 
	4. Add your comment and select “Preview” to review your comment or “Save” to complete your comment. When you select “Save,” you will get a green banner noting submission of your comment. See 
	4. Add your comment and select “Preview” to review your comment or “Save” to complete your comment. When you select “Save,” you will get a green banner noting submission of your comment. See 
	Figure 28
	Figure 28

	. 



	Figure 28 Green Banner Indicating Comment Sent 
	 
	Figure
	5. The Site Moderator receives an email notification and reviews your comment for appropriateness. If the Site Moderator deems your comment appropriate, they will approve your comment for public viewing. If not, the Site Moderator will email you with questions and/or ask you to edit. 
	5. The Site Moderator receives an email notification and reviews your comment for appropriateness. If the Site Moderator deems your comment appropriate, they will approve your comment for public viewing. If not, the Site Moderator will email you with questions and/or ask you to edit. 
	5. The Site Moderator receives an email notification and reviews your comment for appropriateness. If the Site Moderator deems your comment appropriate, they will approve your comment for public viewing. If not, the Site Moderator will email you with questions and/or ask you to edit. 

	6. If someone comments on your suggested eCQM concept and the Moderator approves the comment, you receive an email notification of the approved comment. See 
	6. If someone comments on your suggested eCQM concept and the Moderator approves the comment, you receive an email notification of the approved comment. See 
	6. If someone comments on your suggested eCQM concept and the Moderator approves the comment, you receive an email notification of the approved comment. See 
	Figure 29
	Figure 29

	. 



	Figure 29 Email Notification to Suggested eCQM Concept Author of Comment Publication 
	 
	Figure
	7. The main suggested eCQM Concepts page notes how many approved comments a suggested eCQM concept has, which anyone can see. However, the Last Updated date does not change. The Last Updated date only changes when there are updates to the suggested eCQM concept. See 
	7. The main suggested eCQM Concepts page notes how many approved comments a suggested eCQM concept has, which anyone can see. However, the Last Updated date does not change. The Last Updated date only changes when there are updates to the suggested eCQM concept. See 
	7. The main suggested eCQM Concepts page notes how many approved comments a suggested eCQM concept has, which anyone can see. However, the Last Updated date does not change. The Last Updated date only changes when there are updates to the suggested eCQM concept. See 
	7. The main suggested eCQM Concepts page notes how many approved comments a suggested eCQM concept has, which anyone can see. However, the Last Updated date does not change. The Last Updated date only changes when there are updates to the suggested eCQM concept. See 
	Figure 30
	Figure 30

	.  



	Figure 30 Public Notification of Number of Approved Comments 
	 
	Figure
	8. When opening the suggested eCQM concept, anyone can see the approved comment. See 
	8. When opening the suggested eCQM concept, anyone can see the approved comment. See 
	8. When opening the suggested eCQM concept, anyone can see the approved comment. See 
	8. When opening the suggested eCQM concept, anyone can see the approved comment. See 
	Figure 31
	Figure 31

	. 



	Figure 31 Public Viewing of Approved Comment 
	 
	Figure
	  
	eCQM Testing Opportunities Module 
	Measure developers may request the posting of an announcement of an eCQM testing opportunity. There are numerous reasons e.g., feasibility, reliability, validity, and times a measure developer tests an eCQM. The eCQM Testing Opportunities module lists a few reasons. If you are a CMS-contracted measure developer, please use your CMS cleared announcement using the eCQI 
	Measure developers may request the posting of an announcement of an eCQM testing opportunity. There are numerous reasons e.g., feasibility, reliability, validity, and times a measure developer tests an eCQM. The eCQM Testing Opportunities module lists a few reasons. If you are a CMS-contracted measure developer, please use your CMS cleared announcement using the eCQI 
	template
	template

	 and attach to an 
	email
	email

	 to the eCQI Resource Center. If not a CMS-contracted measure developer, please send an 
	email
	email

	 to the eCQI Resource Center with the completed template, which includes 

	• the name of the organization sponsoring the eCQM 
	• the name of the organization sponsoring the eCQM 
	• the name of the organization sponsoring the eCQM 

	• dates the organization is accepting testing volunteers 
	• dates the organization is accepting testing volunteers 

	• type of feedback the organization wants – and it may be multiple topics, e.g., feasibility of data elements, thoughts from persons and families, reliability, and validity testing 
	• type of feedback the organization wants – and it may be multiple topics, e.g., feasibility of data elements, thoughts from persons and families, reliability, and validity testing 

	• the draft eCQM specifications 
	• the draft eCQM specifications 

	• organization contact information 
	• organization contact information 


	P
	Span
	If the Site Moderator approves, the eCQI Resource Center team will post the announcement of the eCQM Testing Opportunities page. The eCQI Resource Center team will remove the announcement at the end of the period the organization is accepting volunteers. Should you want to extend the period, please send an 
	email
	email

	 to the eCQI Resource Center. 

	P
	Span
	If you are a stakeholder interested in testing eCQMs, review the opportunities in the table at the bottom of the eCQM Testing Opportunities page. The hyperlink in the “Details” cell provides the specific information about the testing opportunity. See 
	Figure 32
	Figure 32

	.  

	Figure 32 Learn More About eCQM Testing Opportunities 
	 
	Figure
	  
	eCQM Data Element Repository (DERep) 
	DERep Overview 
	The eCQM DERep provides additional clarification for all the data elements associated with published and tested eCQMs used in CMS quality reporting and incentive programs and the definitions and clinical focus for each data element. There are no access restrictions in the DERep. An Anonymous User can filter information by data element, eCQM by measured entity, Quality Data Model (QDM) attribute, QDM category, QDM datatype, or QDM entity. The QDM information displayed for an eCQM reflects the version used in
	The eCQM DERep centralizes information from the measure specification, 
	The eCQM DERep centralizes information from the measure specification, 
	Value Set Authority Center (VSAC)
	Value Set Authority Center (VSAC)

	, and the 
	QDM
	QDM

	 to aid in better understanding of the clinical intent and to help with data mapping activities. The intent of the eCQM DERep is not to replace those other resources. Please refer to those sources for more detailed specifications. 

	The DERep updates are part of the eCQM Annual Update process. With the addition of a new year, the oldest year drops off so there are always three years for viewing. The DERep contains information for the immediate past, current, and immediate future performance/reporting periods and reflects the QDM and value set versions for their respective performance/reporting periods. 
	How to Apply Filters 
	The eCQM DERep has multiple filters to help users easily view information of interest. 
	1. From the MC Workspace home page, select the “eCQM Data Element Repository” tab. Select the dropdown list of the “Year” filter to view available options. See 
	1. From the MC Workspace home page, select the “eCQM Data Element Repository” tab. Select the dropdown list of the “Year” filter to view available options. See 
	1. From the MC Workspace home page, select the “eCQM Data Element Repository” tab. Select the dropdown list of the “Year” filter to view available options. See 
	1. From the MC Workspace home page, select the “eCQM Data Element Repository” tab. Select the dropdown list of the “Year” filter to view available options. See 
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	Figure 33 Select Reporting/Performance Period 
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	2. Then select the filter option from the drop down menu. Find a description of the information in each option below the filter boxes. See 
	2. Then select the filter option from the drop down menu. Find a description of the information in each option below the filter boxes. See 
	2. Then select the filter option from the drop down menu. Find a description of the information in each option below the filter boxes. See 
	2. Then select the filter option from the drop down menu. Find a description of the information in each option below the filter boxes. See 
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	Figure 34 Select a Filter Option 
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	3. If you know the topic, e.g., part of the title or the CMS ID, you can search that way by entering the information in “Search”  
	3. If you know the topic, e.g., part of the title or the CMS ID, you can search that way by entering the information in “Search”  
	3. If you know the topic, e.g., part of the title or the CMS ID, you can search that way by entering the information in “Search”  


	  
	Individual Measure Pages 
	The individual measure pages provide the performance/reporting period, CMS Measure ID, version, NQF number, eCQM description, and all the data elements and QDM attributes with hyperlinks used by the eCQM. Every page has a link back to the DERep Home Page. See 
	The individual measure pages provide the performance/reporting period, CMS Measure ID, version, NQF number, eCQM description, and all the data elements and QDM attributes with hyperlinks used by the eCQM. Every page has a link back to the DERep Home Page. See 
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	Figure 35 Individual eCQM Page Example 
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	Select the +Expand All or the individual ^ to see the details of the data elements and attributes. The data elements include information from the VSAC, the QDM datatypes and definitions. The page also has links to the MC Workspace home page and the DERep Home Page See 
	Select the +Expand All or the individual ^ to see the details of the data elements and attributes. The data elements include information from the VSAC, the QDM datatypes and definitions. The page also has links to the MC Workspace home page and the DERep Home Page See 
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	. You can also get directly to the data elements by filtering for eCQM Data Elements. 

	Figure 36 Data Element Expanded from Individual eCQM Page 
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	You may see a data element with the value set object identifier (OID) at the end, e.g., ["Diagnosis": "Bipolar Disorder"] (2.16.840.1.113883.3.464.1003.105.12.1157). This is to disambiguate items with the same name, but use a different value set. 
	If you select the name of the data element rather than +Expand all or the ^, you also get the eCQMs, with hyperlinks, using this data element, see 
	If you select the name of the data element rather than +Expand all or the ^, you also get the eCQMs, with hyperlinks, using this data element, see 
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	, and a link to the MC Workspace home page. 

	Figure 37 Data Element List of eCQMs Using that Data Element 
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	QDM Category Page 
	The QDM category pages provide information from the applicable QDM version. See 
	The QDM category pages provide information from the applicable QDM version. See 
	Figure 38
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	Figure 38 Example QDM Category Page 
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	QDM Datatype Page 
	QDM datatype pages contain a description of the datatypes, any data elements defined by the QDM datatype, and the QDM attribute(s) associated with the QDM datatype. See 
	QDM datatype pages contain a description of the datatypes, any data elements defined by the QDM datatype, and the QDM attribute(s) associated with the QDM datatype. See 
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	Figure 39 Example QDM Datatype Page 
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	QDM Attribute Page 
	The QDM attribute pages display the attribute’s definition and which QDM datatypes use the attribute. See 
	The QDM attribute pages display the attribute’s definition and which QDM datatypes use the attribute. See 
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	Figure 40 Example QDM Attribute Page 
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	QDM Entities Page 
	The QDM entities page provides the definition of the entity. See 
	The QDM entities page provides the definition of the entity. See 
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	Figure 41

	. 

	Figure 41 Example QDM Entities Page 
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